Many parts of the Photoshop workspace follow established rules of the computing road: You open a Photoshop menu just as you do in any program, and the program windows adhere to the standard Windows or Macintosh design. But a few components work in ways that aren’t obvious, so this chapter gives you the lowdown, explaining how to manipulate the Photoshop tools, palettes, and other controls. You’ll also find information that will help you customize your new digital studio.

In This Chapter:

- The Photoshop window
- How to work with palettes and tools
- Recommended program settings
- Tips for optimizing Photoshop’s performance
- Ways to zoom and scroll the picture display
- Rulers and guides for positioning photo elements
Getting Familiar with Photoshop

Figure 1.1 labels the main elements of the Photoshop CS window, which looks virtually identical to its predecessor. The one significant change is that the File Browser is now accessible via a button on the options bar as opposed to being stuck in the palette well. (You can read more about the File Browser in Chapter 3.)

The next several sections provide details on working with these program elements, with the exception of the menu bar, which I won’t discuss for fear of insulting your intelligence. (But do remember that when you see a phrase such as “choose Filter | Sharpen | Unsharp Mask” in this book, it means that you’re supposed to select a series of items from the menus. In this case, you click the Filter menu, click Sharpen to display a submenu, and then click Unsharp Mask in that secondary menu.)
Selecting Tools

The primary Photoshop editing tools are clustered in the top two-thirds of the toolbox, shown in Figure 1.2. (If you don’t see the toolbox, choose Window | Tools.)

To activate a tool, just click its icon. Note, though, that some slots in the toolbox are occupied by more than one tool. For example, the Brush and Pencil tools share the same slot, as illustrated in Figure 1.3. Multi-tool slots are marked with a little black triangle. If you position your cursor over the triangle and then hold down the left mouse button, Photoshop displays a flyout menu containing icons for all tools in the slot, as shown in the figure. Click the tool that you want to use. The icon for the selected tool takes center stage in the toolbox, and the flyout menu disappears.

Time Saver

You also can select tools with the keyboard shortcuts laid out in the upcoming Speed Keys table. Some tools that share a toolbox slot also share a keyboard shortcut. Your first key press activates whichever tool is currently visible in the toolbox; press SHIFT plus the shortcut key repeatedly to cycle through the other tools that share the shortcut. (If the SHIFT-key thing doesn’t work, see the section “General Preferences” later in this chapter.)
If you’re a Mac user and can’t get certain Photoshop keyboard shortcuts to work, you need to tweak your operating system controls. Otherwise, some shortcuts invoke system-related actions instead of Photoshop actions.

- In OS 9, open the Keyboard control panel, click the Function Keys button, and uncheck Enable Hot Function Keys.
- In OS X, choose System Preferences from the Apple menu to open the System Preferences window. Click the Show All icon and then the Keyboard and Mouse icon. Click the Keyboard Shortcuts button and disable conflicting shortcuts. Click Show All again, click the Exposé icon, and disable Exposé shortcuts, too.

### Setting Tool Options

One of the features that makes Photoshop such a powerful program is the flexibility built into its editing tools. Depending on the tool, you can customize its performance in a number of ways:

- **Options bar** The main tool controls live on the options bar, shown in Figure 1.4. To hide and display the options bar, choose Window | Options.
Toolbox color controls
Just underneath the editing tools in the toolbox, you see four controls that establish the colors produced by certain tools. Figure 1.5 points you to these controls; Chapter 5 has details.

Keyboard modifiers
You can affect the behavior of some tools by pressing certain keys. For example, if you press SHIFT while painting with the Brush tool, you limit the tool to creating a line that’s perfectly horizontal or vertical. Look for the Tool Tricks boxes throughout this book to learn the really useful keyboard controls, or modifiers, as Photoshop geeks like to call them.

Working with Palettes
When you first install Photoshop, several palettes appear open on-screen, and other palettes peek their noses out of the palette well, labeled in Figure 1.6. (Don’t see the palette well? Check your monitor display settings. The palettes don’t appear unless the screen resolution is set to 1024 x 768 or higher.)

To open a docked palette, click its tab, shown in Figure 1.6, or choose its name from the Window menu. To display a free-floating palette, choose its name from the Window menu. You also can open some palettes by using the keyboard shortcuts listed in the upcoming Speed Keys table.

In addition to the controls you normally see in a palette, you can display a palette menu that offers related

Figure 1.6: Click a tab to display a palette that’s docked in the palette well.
CHAPTER 1 PHOTOSHOP ROAD MAP

commands. Click the arrow in the top-right corner of the palette to display the menu, as shown in Figure 1.7.

The next few sections provide a few more tips on working with palettes in general. Later chapters detail specific controls in important palettes.

Working with Palette Windows

By default, the free-floating palettes are grouped in palette windows. Figure 1.8 shows the Windows version of a palette window that houses the Layers, Channels, and Paths palettes. The Mac version is identical except for the minimize and close buttons, which follow the OS 9 and OS X standards. Familiarize yourself with the following palette-window maneuvers:

- **Choosing a palette** To switch among the palettes in the palette window, click the palette tabs.
- **Moving a palette window** To relocate a palette window, drag the bar that runs across the top of the window. Officially, that bar is called the title bar, but in this case, there’s no actual title.
- **Resizing a palette window** Drag the lower-right corner of the window to adjust the window size.
- **Collapsing a palette window** When you click the Minimize button, labeled in Figure 1.8, the palette remains open, but with just the top
Figure 1.8: You can group palettes in free-floating windows.

part of the window showing. Click the button again to restore the palette to its original size.

- **Closing a palette window** Click the Close button, labeled in Figure 1.8, to close the palette window.

Rearranging Palettes

If the default arrangement of palettes doesn’t suit you, you can reorganize the palettes as follows:

- **Turn a docked palette into a floating palette** Drag the palette by its tab out of the well.
- **Dock a floating palette** Open the palette menu and choose Dock to Palette Well.
- **Separate a palette in a palette window into an individual, free-floating palette** Drag the palette by its tab out of the palette window.
- **Reorganize palette groupings** To alter the original grouping of palettes in palette windows, just drag the palette tabs from window to window. For example, you can move the Actions palette into the window that holds the Layers, Channels, and Paths palettes. Using this technique, you can combine your most frequently used palettes into a single palette window, which cuts down on screen clutter.
Preserving Palette Positions

If you rearrange or reorganize your palettes, tell Photoshop that you want it to retain the changes before you close the program. In Windows and OS 9, choose Edit | Preferences | General. In OS X, choose Photoshop | Preferences | General. Select the Save Palette Locations box and click OK. To return to the original, default palette setup, choose Window | Workspace | Reset Palette Locations.

Choosing Program Preferences

The Preferences dialog box, shown in Figure 1.9, gives you access to additional options for tweaking Photoshop’s appearance and performance. Open the dialog box via the Preferences | General command, which appears at the bottom of the Edit menu if you’re running Photoshop on a Windows computer or a Mac with OS 9. If you’re working with OS X, look for the command on the Photoshop menu.

The Preferences dialog box is a multi-panel affair, with each panel housing different options. You can select a panel from the drop-down list, labeled in the figure, or cycle through the panels by clicking the Prev and Next buttons.

I could devote a whole chapter to each panel, but frankly, that would not only put us both to sleep, but would also be a waste of time and paper. In most cases, the default settings established by Adobe will serve you well, and many options don’t come into play at all for everyday photo-editing tasks. So the next several sections discuss those settings that you may want to adjust before you start working with Photoshop. I mention certain other options throughout the book, and you can read about the remaining ones in the Photoshop Help system if you’re interested.
General Preferences

Figure 1.9 shows my settings for the options on the General panel of the CS Preferences dialog box, which is slightly different than Version 7. A few items warrant explanation:

■ **Color Picker** A *color picker* is a tool that you use to select paint colors. Stick with the default setting, Adobe; it’s more sophisticated than the alternative, which is the color picker provided by your computer’s operating system (Windows or Mac).

■ **Redo Key** This option specifies what keyboard shortcuts invoke the *Edit | Undo* and *Edit | Redo* commands. While working with this book, use the default option, which sets *CTRL-Z* (Windows) or *⌘-Z* (Mac) as the shortcut for toggling between *Undo* and *Redo*. Otherwise, my instructions related to those commands won’t work.

■ **History States** This setting controls the number of edits the program enables you to undo. You can raise the value higher than the default (20), but doing so increases the demand on your computer’s resources. See Chapter 4 for more about undoing edits and other ways to protect yourself from mistakes.

■ **Use System Shortcut Keys (Mac OS X only)** Turn this one off. Otherwise, some keyboard shortcuts perform an OS X system function rather than a Photoshop function.

■ **Use Shift Key for Tool Switch** This option determines how you cycle through tools that share a keyboard shortcut. If you select the check box, you press *SHIFT* plus the tool shortcut to switch tools; otherwise, every press of the shortcut key by itself toggles the tools. So that we’re on the same page, so to speak, select this option while working with this book.

■ **History Log** Photoshop CS offers an option that logs the changes that you make to an image and preserves the log either as part of the image file or as a separate text file. The feature is designed for users whose jobs require them to keep careful track of what changes are made to a photo. If you fall into that category, read the Help system information about the feature to decide which of the tracking options makes the most sense for your situation. Otherwise, keep the option turned off. Storing the tracking information in the image file increases file size and can strain the program’s performance.
CHAPTER 1  PHOTOSHOP ROAD MAP

Remember
Photoshop stores your preferences data in a file named Adobe Photoshop 7.0 Prefs or Adobe Photoshop CS Prefs. If Photoshop starts behaving strangely, the file may be corrupt. Close Photoshop and use your system’s file-searching function to locate and delete the file (location depends on your operating system). When you relaunch Photoshop, it creates a new preferences file, and your problems may be solved. Unfortunately, all the preferences return to the defaults, so you need to redo any changes that you made to those settings.

File Handling Preferences
Options on the File Handling tab of the Preferences dialog box, shown in Figure 1.10, affect how Photoshop saves and opens image files, topics you can explore in Chapters 3 and 4. You may want to adjust the following options, depending on how you will be working with the program.

Ignore EXIF Profile Tag
Today’s digital cameras store certain bits of extra information in picture files. This data, called EXIF metadata, includes such details as the model of camera, color profile, shutter speed, and other capture settings. The Ignore EXIF Profile Tag option in Photoshop CS relates to the color-profile information.

Giving a recommendation on this option is tricky because the best choice depends upon your camera. Every camera designates a color profile in metadata, but many models don’t report the profile accurately. Instead, they simply assign a tag for the sRGB profile, which you can explore in Chapter 14. As a result, you may not retain all the colors your camera actually captured.

My advice is that unless you’re sure that your camera tags color space information correctly, turn this option on. That way, Photoshop ignores the EXIF profile data.

Enable Large Document Format (.psb)
Normally, Photoshop does not allow you to save a file larger than 2 gigabytes (GB). That limit far exceeds what most users need, but some photographers may on occasion need

For Photoshop 7 users, Adobe offers a free plug-in that provides the same result as enabling the Ignore EXIF Profile Tag option. Look for the plug-in in the Downloads section of the Support area of the Adobe Web site (www.adobe.com).

Enable Large Document Format (.psb)
Normally, Photoshop does not allow you to save a file larger than 2 gigabytes (GB). That limit far exceeds what most users need, but some photographers may on occasion need
to create larger files. For those huge projects, Photoshop CS offers a new large-document format, which carries the file extension .psb. If you want to save files in this format, enable this option. You probably won’t be able to open the file in any program other than Photoshop CS, however.

Maximize PSD File Compatibility
The Maximize PSD File Compatibility option affects files that you save in Photoshop’s native file format, PSD. In Photoshop 7, the option name is slightly different: Always Maximize Compatibility for Photoshop (PSD) Files.

Either way, if you select the check box, the program saves files with extra data that ensures that they can be opened in earlier versions of Photoshop. Because that extra data bloats file sizes, I recommend turning this option off. If you need to share a PSD file with someone who’s using an older incarnation of Photoshop, you can turn on the option before saving the file.

Enable Workgroup Functionality
Photoshop 7 provides the Enable Workgroup Functionality option for users who collaborate on images with co-workers in a workgroup setting. Among other things, the feature enables you to control who can make changes to a file stored on a workgroup server. If you’re part of a team that uses Photoshop in this fashion, ask your workgroup administrator when and how to implement the feature. Otherwise, turn it off.

Enable Version Cue Workgroup File Management
Version Cue is a new, updated version of the workgroup features found in Version 7. Again, check with your workgroup poobah to find out what settings to use. If you’re not part of a workgroup, turn the option off. Note that Version Cue features aren’t available unless you own the entire Creative Suite.

Display & Cursors Preferences
Figure 1.11 shows my recommended settings on the Display & Cursors panel of the Preferences dialog box. Three settings deserve comment:

- **Color Channels in Color** Photoshop enables you to view the individual color channels that make up a digital image, a topic you can
explore in Chapter 2. If you turn this option on, Photoshop displays a tint over the channel image to remind you what color channel you're viewing. Nice idea, but the tint hinders your ability to evaluate the channel contents, so turn this option off.

- **Painting Cursors** When you work with tools that feature customizable brushes, you can choose from three cursor styles: Standard, Precise, and Brush Size, illustrated in Figure 1.12. Brush Size is the best choice. With this option selected, your cursor reflects the size and shape of your brush.

- **Other Cursors** These options affect the brushless tools. Precise gives you the best indication of what area your tool is about to alter.

Tool Tricks

While working with a tool that has a customizable brush, press the **CAPS LOCK** key to toggle between the Brush Size and Precise cursor styles. (For this trick to work, you must select Brush Size on the Display & Cursors panel of the Preferences dialog box.) Turn off **CAPS LOCK** before you use other keyboard shortcuts, though, or the shortcuts may not work correctly.
Plug-Ins & Scratch Disks

To flex its muscles, Photoshop requires plenty of RAM (system memory). But RAM alone isn’t enough. As you run the program, it uses empty space on your computer’s hard drive as a temporary data-storage tank. Computer folk refer to that temporary storage space as the *scratch disk*.

On computers that have a single, nonpartitioned drive, Photoshop automatically sets that drive as the primary scratch disk. If your computer has multiple hard drives or a single hard drive that is partitioned into several virtual drives, visit the Plug-Ins & Scratch Disks panel of the Preferences dialog box, shown in Figure 1.13. Here, you can designate the order in which you want Photoshop to access your drives for its scratch disk needs. Select the drive that has the greatest amount of free space from the First drop-down list, select the next-roomiest drive from the Second drop-down list, and so on.

*Figure 1.12: You can customize the appearance of tool cursors.*
Regardless of how many drives your system boasts, make sure that you give Photoshop substantial scratch disk space. If the program acts squirrely or displays a message saying that the scratch disk is full, delete unneeded files from your hard drive.

Memory & Image Cache

By default, Photoshop helps itself to as much as 50 percent of your available RAM. If the program gets bogged down when you work on large image files, you may want to allow it to consume even more memory.

In Windows and Mac OS X, you make this change from inside Photoshop, using the Memory & Image Cache panel of the Preferences dialog box. Try bumping up the value in the Memory Usage section of the panel by 10 or 20 percent. You must close and reopen the program for this change to take effect.

In Mac OS 9, you assign RAM to individual programs via an operating system control. After closing Photoshop, locate the Photoshop program icon at the Finder level. Click the icon and choose File | Get Info | Memory. In the resulting dialog box, try raising both the Minimum and Preferred values.

Watch Out!

Don’t feed Photoshop all your computer’s RAM, or the computer won’t be able to run the operating system itself or the other programs that normally run in the background while you’re working. For safety’s sake, limit Photoshop’s memory allocation to 75 percent of the available RAM.

Viewing Pictures

Every open image in Photoshop appears inside its own window, as shown in Figure 1.14. You get the standard Windows or Mac controls for closing, minimizing, and restoring windows, as well as scroll bars for scrolling the image display.
Use these tactics to get a closer look at your photo or pull out for a wider view:

- Click the Zoom tool, labeled in Figure 1.14, and click the image. Keep clicking to zoom in further. To zoom out, ALT-click (Windows) or OPTION-click (Mac).
- Use the keyboard shortcuts listed in the upcoming Speed Keys table.
- Choose Window | Navigator to open the Navigator palette, shown in Figure 1.15. Drag the zoom slider to the right to zoom in, drag the slider left to zoom out. Alternatively, click the zoom-in and zoom-out buttons at each end of the slider.

To scroll the image display, select the Hand tool, labeled in Figure 1.14. Then drag in the image window. If the Navigator palette is open, you can also drag the box that appears on the image thumbnail. Just drag the box over the area you want to see.

Figure 1.15: The Navigator palette offers one way to scroll and zoom the image.

Tool Tricks
Press H to select the Hand tool. Or press the spacebar to temporarily switch to the Hand tool while any editing tool is active. Release the spacebar to go back to the editing tool you were using.
CHAPTER I PHOTOSHOP ROAD MAP

Displaying Rulers and Guides

You can display rulers across the top and left side of the image window, as shown in Figure 1.16. To hide and display the rulers quickly, press CTRL-R (Windows) or ⌘-R (Mac). Or, if you're feeling overwhelmed by all these shortcuts, choose View | Rulers. Specify the rulers’ unit of measurement as follows:

- In Windows, right-click a ruler, which displays a pop-up menu of options.
- On a Mac, CTRL-click a ruler to get the pop-up menu.

*SPEED KEYS: Zooming the Image Display

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in</td>
<td>CONTROL-+ (plus)</td>
<td>⌘+ (plus)</td>
</tr>
<tr>
<td>Zoom out</td>
<td>CONTROL-- (minus)</td>
<td>⌘-- (minus)</td>
</tr>
<tr>
<td>Fit entire image</td>
<td>CONTROL-0 (zero)</td>
<td>⌘-0 (zero)</td>
</tr>
<tr>
<td>Display actual pixels*</td>
<td>ALT-CONTROL-0 (zero)</td>
<td>OPTION-⌘-0 (zero)</td>
</tr>
</tbody>
</table>

*Matches one image pixel to one screen pixel; see Chapter 2 for details.

Figure 1.16: The rulers come in handy for positioning photo elements.
Alternatively, on either platform, double-click a ruler to open the Rulers and Units panel of the Preferences dialog box. Select the unit that you want to use from the Rulers drop-down list.

By dragging outward from a ruler, you create a guide, as shown in Figure 1.16. Guides are helpful for checking alignment and positioning of picture elements. Use these techniques to manipulate guides:

- **Reposition a guide** Select the Move tool, labeled in Figure 1.16. Place it over the guide until the cursor changes into a two-headed arrow and drag to move the guide.
- **Prevent guides from moving** Choose View | Lock Guides.
- **Delete a guide** Select the Move tool and then drag the guide back to the ruler from whence it came. To delete all guides, choose View | Clear Guides.
- **Hide and display guides** Press `CTRL-;` (Windows) or `⌘-;` (Mac) or choose View | Show | Guides.
- **Change the guide color and style** Head for the Preferences dialog box, introduced earlier in this chapter. Options for customizing guides appear on the Guides, Grid & Slices panel.

### Displaying the Grid

If you choose View | Show | Grid, Photoshop displays a grid of dotted lines over your image, as shown in Figure 1.17. I use this feature primarily when I’m trying to correct convergence distortion, a subject covered in Chapter 13. The gridlines serve as a useful guide for getting things back into proper vertical alignment. As with the guides, you can customize the grid on the Guides, Grid & Slices panel of the Preferences dialog box.

Figure 1.17: Turn on the grid for guidance when correcting convergence problems.